GIS Investigations: Earth Science
to Accompany ArcView Version 3.x

Data Detectives:
Dynamic Earth
Student Activities

Michelle K. Hall
Science Education Solutions, Inc.

Anne K. Huth
Science Education Solutions, Inc.

C. Scott Walker
Harvard University

Larry P. Kendall
Science Education Solutions, Inc.
The authors also wish to thank the many scientists who took the time to learn about this project and share critical research data and expertise, and to the agencies and individuals that have given us permission to include their outstanding illustrations and photos.
# Table of contents

*Introduction*

Getting started ........................................................................................................ i

- Important notice ................................................................................................. i
- Macintosh compatibility note ............................................................................. i
- Installation and setup checklist ......................................................................... i
- What’s included .................................................................................................. ii
- What you need to know ..................................................................................... ii
- Using ArcView GIS ............................................................................................ v

Troubleshooting .................................................................................................... vi

Using these materials ............................................................................................ x

- Visual cues and basic skills ................................................................................ x
- Working with large numbers .......................................................................... xi
- Estimating percent area ................................................................................... xii
- The ArcView GIS user interface ....................................................................... xiv

Curriculum design .................................................................................................. xv

- The 5-E Learning Cycle .................................................................................... xv
- Teaching science with a GIS .......................................................................... xvi

Module overview .................................................................................................. xix

- Key concepts ...................................................................................................... xix
- Unit descriptions .............................................................................................. xix
- National Science Education Standards ......................................................... xxi
- NSES cross-reference chart ........................................................................... xxii

Teaching tips .......................................................................................................... xxiii

- Preparing your students ................................................................................... xxiii
- Before you begin ............................................................................................... xxiv

Design philosophy ................................................................................................ xxv

- Investigating relevant problems ..................................................................... xxv
- Thinking scientifically ..................................................................................... xxv
- Planning to learn .............................................................................................. xxvi
- GIS made easier ............................................................................................... xxvi
Investigations

Unit 1 - Searching for Evidence ................................................................. 1
  Warm-up 1.1 — A changing Earth ........................................................ 3
  Investigation 1.2 — Investigating Earth's clues ..................................... 5
  Reading 1.3 — Discovering plate tectonics .......................................... 19
  Investigation 1.4 — Analyzing plate boundaries .................................. 25

Unit 2 - Exploring Plate Tectonics .............................................................. 31
  Warm-up 2.1 — Testing plate tectonics .................................................. 33
  Investigation 2.2 — Investigating seafloor age ...................................... 35
  Reading 2.3 — Determining seafloor age ............................................. 37
  Investigation 2.4 — Investigating plate motion ..................................... 41

Unit 3 - Earthquake Hazards ................................................................. 51
  Warm-up 3.1 — The Great Lisbon Earthquake ...................................... 53
  Investigation 3.2 — Deadly earthquakes ............................................. 61
  Reading 3.3 — Seismic hazards ............................................................ 69
  Investigation 3.4 — Seismic risk and society ........................................ 77

Unit 4 - Volcano Hazards ................................................................. 85
  Warm-up 4.1 — The tragedy of Mont Pelée ........................................ 87
  Investigation 4.2 — Deadly volcanoes ............................................... 95
  Reading 4.3 — Volcanic hazards .......................................................... 101
  Investigation 4.4 — Volcanoes and climate ....................................... 109

Unit 5 - Tsunami Hazards ................................................................. 117
  Warm-up 5.1 — Scotch Cap Lightstation .......................................... 119
  Investigation 5.2 — Deadly tsunamis ................................................. 123
  Reading 5.3 — Analysis of a tsunami ................................................ 131
  Investigation 5.4 — Tsunami warning ............................................... 139
  Investigation 5.5 — 2004 Indonesian tsunami ..................................... 145
Getting started

Getting started

Important notice

Geographic Information System (GIS) software is not included in this package, and must be licensed separately. This version of the Data Detectives series requires an educational site license for ArcView GIS version 3.x software from ESRI, Inc. If you are using ArcGIS version 9.x software, you must use the ArcGIS 9.x version of the Data Detectives series. Contact the publisher for details.

For more information on K-12 educational licensing options, go to:

http://www.esri.com/industries/k-12/education/licenses.html

Macintosh compatibility note

ArcView GIS 3.0a for Macintosh runs under MacOS 8.x or 9.x, or Mac OS X in the Classic environment. ArcView GIS for Macintosh is not compatible with Mac OS X version 10.4 (Tiger) or Intel processor-based Macintosh computers.

ArcView GIS for Windows will run on Intel processor-based Macintosh computers using:

- Boot Camp (Apple) and Windows 2000 or newer.
- Parallels Desktop software and Windows 98 or newer.

Installation and setup checklist

- Read installation and setup instructions (pages ii–iv).
- Be sure that computers meet system requirements (page ii).
- Install ArcView GIS version 3.x software according to the publisher’s instructions.
- (Windows 2000 and XP only) Download and install the Windows XP patch.
- (Macintosh only) Install the ArcView Dialog Designer Extension from the CD-ROM.
- Install or update QuickTime, if necessary.
- Install or update Adobe Reader, if necessary.
- Copy the Unit data folders from the Data Detectives CD-ROM to each computer’s hard drive or to a shared volume on a server.
- Set default applications for opening media files.
Data Detectives: Dynamic Earth

Introduction

Additional resources
Visit The SAGUARO Project Web site for updates, references, and links to related Web sites:

www.scieds.com/saguaro

What’s included
Each Data Detectives module includes:

- A binder of answer keys and teaching notes.
- A CD-ROM of reproducible student pages and GIS data sets for the investigations.

What you need to know
You and your students should know these basic computer skills:

- Turning the computer on and, if necessary, logging in as a user.
- Navigating the file system to find folders, applications, and files.
- Launching applications and opening files.
- Using basic interface elements — opening, closing, moving, and resizing windows, using tools, buttons, menus, and dialog boxes.

Other than this general computer knowledge, students and instructors need no prior experience with ArcView GIS software. We do, however, strongly recommend that instructors run through each investigation before presenting it to their students, to familiarize themselves with the content and GIS techniques. We also strongly recommend that students and instructors:

- Understand the visual cues used in these materials.
- Read all instructions carefully.
- Pay attention to information provided in computer screen shots and in the margin notes on each page.

Minimum system requirements
Computers must meet the following minimum requirements to use this version of the Data Detectives series:

- Windows* — 500 MHz Pentium 3 or faster CPU running Windows 98 or newer. Compatibility with Windows Vista is unknown at the time of this publication.
- Macintosh — 500 MHz G3 or faster CPU, running MacOS 8.x, 9.x, or Mac OS X in the Classic environment**. ArcView GIS for Macintosh version 3.0a is not compatible with MacOS 10.4 (Tiger).

On Intel processor-based Macintosh computers, ArcView GIS for Windows version 3.x can be used if an appropriate version of Windows is installed under Apple's Boot Camp (Windows 2000 or XP) or Parallels Desktop (Windows 98 or newer) software.

- 128 MB total RAM (64 MB of available application RAM).
- CD-ROM drive (for installing data sets).
- Up to ~1.5 GB free space on hard drive for data, depending on the number of module(s) used.

*Are you running Windows 2000 or XP?
If you are running ArcView GIS under Windows 2000 or XP, you must run the Windows XP patch application, provided in the Software folder on the Data Detectives CD-ROM after installing ArcView.

**The Mac OS X Classic environment
To run ArcView under Mac OS X, you must have the Classic environment installed. Consult your computer’s documentation or your system administrator for assistance.

Getting started
Data Detectives: Dynamic Earth

Required software

The following software is required by this version of the Data Detectives series. Install each according to its publisher’s instructions.

- ArcView GIS 3.0–3.3 for Windows or ArcView GIS 3.0a for Macintosh. (Not included. Must be licensed from ESRI or an ESRI-authorized reseller.)
- ArcView Dialog Designer extension. (Pre-installed with ArcView for Windows, versions 3.1–3.3. Separate installation required for Macintosh. This extension is included on the Data Detectives CD-ROM.)
- QuickTime™ 5 or newer. (Free download from www.apple.com/quicktime/download/)

Copying data to your local hard drive or server

To work properly, you must copy the GIS data sets from the Data Detectives CD-ROM to your computer’s hard drive or to a server. The data sets are organized in folders on each module CD-ROM, with a separate folder for each unit of the module.

<table>
<thead>
<tr>
<th>Data Detectives module name</th>
<th>Folders to copy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dynamic Earth</td>
<td>Dynamic and Hazards</td>
</tr>
<tr>
<td>Tropical Cyclones</td>
<td>Cyclones</td>
</tr>
<tr>
<td>Where’s the Water?</td>
<td>ddww_unit_1 through ddww_unit_4</td>
</tr>
<tr>
<td>The Ocean Environment</td>
<td>ddoe_unit_1 through ddoe_unit_4</td>
</tr>
</tbody>
</table>

About the CD-ROM

The CD-ROM included with each Data Detectives module does nothing by itself—to use the data sets, they must be copied to each computer (preferred) or to a shared server volume accessible to all computers. Reading the data sets directly from the CD-ROM is not recommended.

Why all these guidelines?

Unfortunately, these guidelines are determined by the requirements of ArcView GIS software, and are not within the control of the authors. Rest assured that by carefully following these guidelines, you will be rewarded with trouble-free operation.
your school security policy, an alternative approach is provided in the investigation.

**Monitor resolution**

The *Data Detectives* modules were designed for use with a monitor resolution of at least 1024 by 768 pixels and 256 or more colors. Consult your local technical support specialist or your computer’s documentation if you need assistance with setting your monitor resolution.

**Problems?**

Help with common installation and use problems can be found in the *Troubleshooting* section of this introduction.
Using ArcView GIS

Launching ArcView and opening project files

- Double-click the ArcView application icon 📁 to launch ArcView.
- Windows only — choose the Open an existing project option and click OK.

- Choose File ▶ Open.
- Navigate to the unit folder you installed on your local hard drive or server and open it. Locate the specified ArcView project file — it ends with the extension .apr — and open it.
- Windows only — When you open a Data Detectives project file, you will get the following alert message. It makes no difference whether you answer Yes or No — flip a coin, or just always answer the same way.

Closing project files

When you have completed an activity or must stop for some reason, choose File ▶ Exit and click No when asked if you want to save your changes. (Don’t worry if you click Yes. The files have been locked to prevent accidentally modifying or erasing them.)
Troubleshooting

*Help, updates, and resources*

For corrections, updates, and additional resources related to the *Data Detectives* series, visit the SAGUARO Project Web site at:

www.scieds.com/saguaro/

*Online help*

This module provides all of the directions you need to complete the activities using ArcView GIS. If you wish to explore ArcView on your own, or learn more about ArcView’s capabilities, you may wish to consult ArcView’s Help menu. Choose Help ▶ Help... How to Get Help... to learn more about using ArcView’s built-in help system.

*Printing the pdf files in the Docs folder*

The Docs folder contains the following reference materials, which you can view or print using Adobe Reader software.

- **Guide to ArcView GIS.pdf** — a quick reference manual to frequently used ArcView tools and techniques. These instructions are based on the default user interface for ArcView GIS, and do not include the enhancements provided in the *Data Detectives* investigations. This guide is particularly useful for anyone using ArcView to conduct independent investigations and projects.
- **SAGUARO Tools.pdf** — explains the interface and usability enhancements to ArcView developed by the SAGUARO Project and built into the *Data Detectives* project files.
- **Data Dictionary.pdf** — provides information about the data used in this module, including a description of where the data came from and how they were processed. You do not need this information to complete the activities, but it may be useful if you are using the data for independent research.
Frequently asked questions

“When I insert the CD-ROM that came with the package, nothing happens.” (Macintosh and Windows)

This is normal. The CD-ROM contains only data that must be copied to each computer or to a server to be used.

“When I try to launch ArcView, I get an error message that says ‘Classic Startup found no system folder on the boot volume from which to start Classic.’” (Macintosh OS X only)

ArcView GIS runs in the Classic environment under Mac OS X. If the Classic environment has not been installed, consult your computer’s documentation or your system administrator for assistance.

“ArcView crashes while launching.”

- Macintosh only — ArcView may not have enough memory to work properly (see sidebar at left). Consult your computer’s documentation or system administrator for help in increasing ArcView’s memory allocation.
- ArcView may be damaged. Try uninstalling and reinstalling the ArcView GIS application.

“When I try to open a project file from within ArcView, it tells me it can’t find the project file.” (Windows only)

This can occur if there is a space in the name of the drive or folder into which you copied the unit folder. ArcView for Windows cannot locate a file correctly if it encounters a space in the file's pathname. If necessary, change spaces in drive and folder names to underscore characters — thus, a folder named Class Data should be renamed Class_Data.

“When I open a project file, ArcView tells me that it cannot find files that I know are installed.”

The project file contains a path to the location of each data file in the project. If you move files or rename any of the files or folders that were installed, ArcView cannot find the files. If you cannot restore the correct file and folder names and locations, delete the ddde_unit_x folder and re-install it on the hard drive.

“ArcView launches and opens the project file, but it crashes later, after several minutes of use.” (Macintosh only)

The memory allocation for ArcView is probably too low (see sidebar). Consult your computer’s documentation or system administrator for help in increasing ArcView’s memory allocation.

Macintosh users — increase ArcView’s memory allocation!

To provide trouble-free operation, Macintosh users must increase ArcView’s default memory allocation. Set the Minimum Size to at least 32000 K and the Preferred Size to at least 64000 K.

Consult your computer’s documentation or your local technical support specialist if you need help making this change.

<table>
<thead>
<tr>
<th>Memory Requirements</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Suggested Size:</td>
<td>12004 K</td>
<td></td>
</tr>
<tr>
<td>Minimum Size:</td>
<td>32000 K</td>
<td></td>
</tr>
<tr>
<td>Preferred Size:</td>
<td>48000 K</td>
<td></td>
</tr>
</tbody>
</table>

Troubleshooting
“When I ________ in ArcView, nothing (or the wrong thing) happens.”

Most ArcView errors are caused by not activating the correct theme before performing certain operations. By activating a theme, you are telling ArcView which data to operate on. If the wrong data are identified, the operation will fail or produce unexpected results.

“When I use the Identify tool or perform certain operations, ArcView gives me an error message or crashes.” (Windows XP, 2000 only)

You must update ArcView 3.2, 3.2a, and 3.3 for Windows using the Windows XP patch application, ArcViewGISPatchWinXP.EXE, located in the Software folder on your Data Detectives CD-ROM.

“When I open an ArcView project file, ArcView crashes or I get an error message saying that the Dialog Designer extension cannot be found.” (Macintosh only)

Dialog Designer is a free ArcView extension that is required by all project files in the Data Detectives series. Quit ArcView and run the Dialog Designer Installer application, found on your Data Detectives CD-ROM.

“When I try to create a summary table (using the Summarize button), ArcView crashes and I get an error message saying that a directory is not writeable.”

When creating a summary table, ArcView writes a small database file to your computer’s hard drive, in the same folder (or directory) that contains the project file for the unit. See your technical support specialist about giving read/write permission to the unit folder and its enclosed folders. If this is not possible, students can open a pre-built copy of the file that has been saved for them. Instructions for opening this file are given in the sidebar next to each Summarize operation.

“When I try to view a QuickTime movie or animation, I get the message ‘Required compressor not found.’”

This message means that you are using an older version of QuickTime that does not support the data compression format used for the movie. Install QuickTime 5 or newer to correct this problem.
“When I use the Media Viewer to view movies or animations, I get a message inviting me to upgrade to QuickTime Pro. When I click the ‘Later’ button, nothing happens.”

This occurs because the QuickTime preferences file is not “writable” to all users. The preferences file is called QuickTime.qtp; its exact location depends on the version of Windows you are using. Consult your system administrator about making the necessary changes.

“QuickTime movies don’t play smoothly.”

The quality of QuickTime movie playback depends on many factors. Quit any unused applications that are running, and be sure you are using QuickTime 5 or newer.

“When I use the Media Viewer to load an animation or Web page, ArcView freezes.” (Mac OS X only)

ArcView runs in the Macintosh Classic environment, whereas QuickTime Player and your Web browser both run natively under OS X. When you launch a Web page or animation, ArcView waits for a confirmation that the correct software has answered its request to open the file. Sometimes, ArcView does not always receive or acknowledge this confirmation, even though the file opens properly. ArcView “gives up” after waiting about a minute, and resumes its normal behavior. If you are patient, the “freeze” will clear in about 60 seconds, allowing you to continue the investigation. We apologize for this apparent bug, which is beyond our control!
Using these materials

**Visual cues and basic skills**

Visual cues are used to make the activity directions easier to follow.

- A line preceded by the computer symbol 🖥️ is an instruction — something to do on the computer.
- When a tool or button is required, the name of the tool or button is capitalized and is followed by a picture of that item as it appears on screen — for example, the Identify tool 🗺️.
- The ➤ symbol between two boldface words in text indicates a menu choice. Thus, **Theme ➤ Properties** means “pull down the Theme menu and choose Properties.”

**The sidebars contain important information**

The page sidebars contain useful information such as definitions, explanations, illustrations, examples, reminders, warnings, tips, and hints. If you are not sure what to do, look for help in the sidebar first.

**Activating themes**

The most common problem encountered when using ArcView GIS software is failing to activate the correct theme (map layer) before performing an operation. In most cases the instructions specifically note when to activate a theme, but users often skip over this detail, or confuse **activating a theme** with **turning a theme on**. Turning a theme on makes the theme visible on the map; activating a theme allows users to do calculations or other procedures on the theme's database.

To activate a theme, click on the theme's name in the Table of Contents, the list of themes to the left of the map view. Active themes have a raised border in the Table of Contents. When an operation does not have the expected result, this is the first thing to check. (Note: Double-clicking the theme name activates the theme and opens the Legend Editor window for that theme.)

**Zooming**

Another common source of problems is not looking closely enough at the maps to see the necessary feature(s). ArcView has tools for zooming in and out of the map view that work just like tools you may have used in other applications. If you zoom in so far that you don't know where you are, you can back up to previous zooms by clicking the Previous extent button 🌋. You can also zoom out quickly to see the entire map by clicking the Full Extent button 🌋 or by choosing **View ➤ Full Extent**.
**Working with large numbers**

Some of the numbers you will work with in these investigations are quite large. When talking about the amount of water in the ocean or the energy of an earthquake or hurricane, you routinely use values in the billions or even trillions. Where possible, ArcView has been modified to make these very large and very small numbers easier to read. For example, in the Statistics window shown at left, the total area is given as 349.96 trillion, rather than 349,958,342,077,361 square meters.

Occasionally, you will need to convert billions to trillions or millions, or vice versa. For example, to convert the Mean value in the example at left from billions to trillions, move the decimal point three places to the left. To go from billions to millions, move the decimal three places to the right.

\[ 14490 \text{ million} = 14.49 \text{ billion} = 0.01449 \text{ trillion} \]

**Rounding**

Most of these numbers are approximations, so it does not make sense to be overly precise when you are calculating or recording them. Look at the number written below, and the values of each of the digits. Face it — when you are talking about nearly 149 billion of something, who cares about hundred-thousandths, or even tens of millions?

Throughout these investigations, you will be asked to round answers to a particular value and number of decimal places, such as “Round your answer to the nearest 0.1 million.” Rounding numbers is simple, if you follow three steps. Examples are shown at the left.

1. Look only at the numeral to the right of the place value you are rounding to. For example, when rounding to the nearest thousand, look only at the numeral in the hundreds place.
2. If the numeral to the right is 0-4, do not change the number you are rounding to. If the number to the right is 5-9, add one to the number you are rounding to.
3. Change whole numerals to the right of the place you are rounding to into zeros, and omit all unused decimal places.
4. For any number less than 1, be sure to include a zero to the left of the decimal point.

**Rounding examples**

For example, if your number is 319,740,562.85

To round to the nearest ten million:

- Find the ten millions digit (1).
- Look at the number to its right (9). Because it is between 5 and 9, add one to the ten millions digit.
- Change the whole numbers to the right of the ten millions digit to zeros. The result is 320,000,000.

Rounding to the nearest...

<table>
<thead>
<tr>
<th>Value</th>
<th>Number</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>ten million</td>
<td>319,740,562.85</td>
<td>320,000,000</td>
</tr>
<tr>
<td>hundred thousand</td>
<td>319,740,600</td>
<td>319,740,000</td>
</tr>
<tr>
<td>ten thousand</td>
<td>319,740,560</td>
<td>319,740,000</td>
</tr>
<tr>
<td>thousand</td>
<td>319,740,563</td>
<td>319,741,000</td>
</tr>
<tr>
<td>hundred</td>
<td>319,740,562.9</td>
<td>319,740,600</td>
</tr>
</tbody>
</table>

To round to the nearest 0.1 million:

- Find the 0.1 millions digit (7). This is also called the hundred thousands digit.
- Look at the number to its right (4). Because it is between 0 and 4, do not add one to the 0.1 millions digit.
- Insert the decimal point in the proper location. The result is 319.7 million.
**Rounding decimal fractions**

Rounding decimals works the same way, except that you are rounding to tenths, hundredths, thousandths, and so on. Do not add zeros to the right of the decimal point. In other words, rounding 2.587 to the nearest tenth is 2.6, not 2.600.

**Estimating percent area**

You will occasionally be asked to estimate the percent area covered by land, ocean, or some other feature. This is a difficult skill for some people to master, but can be learned with practice.

**Comparing to standards**

One method of estimating coverage is to compare to visual standards. When estimating coverage you need to consider how the features are arranged.
**Gridding**

Another approach to estimating coverage is to divide the area up into a grid, either mentally or physically, and determine the number of grid squares that are at least half-covered. To find the percent coverage, calculate the ratio of covered squares to total squares and multiply by 100. In the example at left, approximately 20 of the 50 squares are at least half covered.

\[
\frac{20}{50} \times 100 = 40\% \text{ coverage}
\]
The ArcView GIS user interface

Basic elements
The elements of the ArcView interface are the same for the Windows and Macintosh versions, except for the location of the Status Bar.

- Buttons are shortcuts to basic GIS operations and added features. When you click a button, something happens immediately.
- Tools allow you to interact with map features and edit graphics. To use a tool, click on its toolbar icon, then click or drag on the Map View. The cursor changes to indicate the tool you are using.

The SAGUARO Tools
For more information about ArcView’s buttons and tools and the usability enhancements developed by the SAGUARO Project, see the SAGUARO Tools .pdf file in the Docs folder of the Data Detectives CD-ROM.
The 5-E Learning Cycle

The Data Detectives series was designed using the 5-E Learning Cycle model, which promotes inquiry and exploration as a process for learning science. The Learning Cycle, originally credited to Karplus and Thier (The Science Teacher, 1967) and later modified by Roger Bybee for the Biological Sciences Curriculum Study (BSCS) project, proposes that learning something new or understanding something familiar in greater depth involves making sense of both prior experience and firsthand knowledge gained from new explorations. The 5-E model divides learning experiences into five stages: Engage, Explore, Explain, Elaborate, and Evaluate. Each stage builds on the previous stages as students construct new understanding and develop new skills.

Engage

This stage is designed to help students understand the learning task and make connections to past and present learning experiences. The activity should stimulate interest and prompt students to identify their own questions about the topic. Typical activities in this stage include posing a question, defining a problem, or demonstrating a discrepant event, then using small group discussions to stimulate and share ideas. To connect science to students’ lives, we frequently use historical events, such as natural disasters, to stimulate curiosity and motivate learning. Your role as the instructor is to help students connect previous knowledge to the new concepts introduced in the unit.

Explore

In the Exploration stage, students investigate key concepts by exploring scientific, geographic, and economic data sets. Students begin identifying patterns in the data and connecting them to Earth processes. This further arouses student curiosity and new questions develop. Frequently, students diverge from the written activity to explore their own questions, continually building on their knowledge base. Through this process of questioning and exploration, students begin to formulate their own understanding of basic concepts. In this stage, your role is to observe and listen to students as they interact with one another and with the data sets. This includes asking questions to help students clarify their understanding and redirecting their investigations when necessary. It is critical to give students adequate time to thoroughly investigate the guiding questions in the module, as well as the questions they have generated themselves.
**Explain**

In this stage, students are introduced more formally to the lesson's scientific and geographic concepts. Through readings and discussions, students gain an understanding of major concepts and verify answers to questions or problems posed earlier. In addition, more abstract concepts not easily explored in earlier activities are introduced and explained. As students formulate new ideas to interpret observations made in the Explore stage, appropriate vocabulary is introduced. If students have unresolved questions, they may continue to look for solutions in the next stage.

**Elaborate**

In the Elaborate stage, students expand on what they have learned and apply their newfound knowledge to different situations. They test ideas more thoroughly and explore deeper relationships. Providing closure to the lesson and verifying student understanding is critical at this point.

**Evaluate**

The learning cycle provides opportunities to gauge your students’ understanding and to monitor their progress using questioning techniques and discussions. More formal evaluation can be conducted at this point. The assessment should be aligned with the style and content of the learning experience. Where appropriate, we have provided assessments in which students create summary projects or reports.

**Teaching science with a GIS**

Geographic Information Systems (GIS) provide an ideal vehicle for teaching topics in Earth and environmental sciences and helping students develop scientific problem-solving skills. Formerly limited to professionals with access to high-end computer workstations, today GIS is accessible to many, and is being used by students from elementary through graduate school. GIS has a number of advantages over traditional materials when used as an instructional tool. These include:

- **Data visualization** — GIS-based investigations allow students to identify and characterize relationships by manipulating multiple visual representations of data, including dynamic and customizable maps, tables, charts, and animations.
- **Data analysis** — Analytical tools enable students to quantify relationships within and among spatial data sets using database functions, statistical analyses, and spatial overlay operations.
- **Multimedia integration** — Other forms of digital information, including animations, video, audio, and digital stills, can be woven into GIS activities, greatly enriching and extending the learning experience.
• **Technology literacy and transferable skills** — The use of GIS promotes technology literacy and provides students with skills transferable to their own research, other course work, and the workplace.

GIS-based instructional modules have the potential to enhance student learning by reinforcing concepts through discovery and by improving problem solving, visualization, and computational skills.

**GIS for novice learners**

Most instruction using GIS is taught in college at the advanced undergraduate or graduate level and focuses initially on learning the software. Only later does the focus shift to the use of GIS as a tool for problem solving. Such instruction is provided for those who have specific research objectives or who want to become GIS professionals. Teaching with GIS in grades K-14 is almost unheard of, especially to students who are not seeking to become GIS professionals. This module and others in the series are among the first to promote learning with GIS rather than learning about GIS science at these grade levels.

So, how do we make learning with GIS possible and rewarding for students, when many of the GIS experts feel that the tool is beyond the grasp of novices? Our pedagogical approach is twofold: Use the 5-E Learning Cycle to guide learning, and simplify the complex mechanics of GIS technology while highlighting data exploration and scientific discovery. These materials reflect what we have learned during the development process:

- Focus on teaching science content, not GIS skills.
- Use data sets that are rich with information.
- Prepare and display the data in ways that minimize both instructor and student busywork.

Focusing on engaging problems also motivates students to learn. Our investigations accomplish this by:

- Progressively examining phenomena from the global scale to the regional and local scales.
- Uniting science and society in an integrated system.
- Incorporating cutting-edge data from active research programs.

Global-scale investigations introduce the fundamental science concepts and driving forces behind Earth processes, reviews pertinent geography and nomenclature, and set the stage for regional- and local-scale investigations. This progression from global to local scale helps students relate global phenomena to a world they recognize.

The expanding variety of techniques for gathering data and the rapid dissemination capability of the Internet create opportunities to dramatically improve educational materials with real scientific data. Global data sets such as the Global Seismic Hazard Map, LandScan 2000.
global population data, GTOPO30 global topography, global seafloor age, World Ocean Atlas, and the CIA World Factbook economic data are examples of the many research products that we obtained and enhanced to form the rich data core of our activities. By integrating multimedia resources, we are able to use non-spatial data such as animations, Web links, and spreadsheets to reinforce key concepts. For large classes, this can help to accommodate a wide variety of learning styles.

Implementing the curriculum
Ideally, the guided investigations provided by the Data Detectives series will become springboards for using GIS and other geospatial technologies and data sets as tools for student-developed investigations. In field testing, we observed that most students diverged from the assigned investigation to explore their own questions when they became intrigued by patterns in the data. Similarly, the time spent investigating students’ own questions increased as experience with the tools and knowledge of the topic increased. Not surprisingly, we also observed that the complexity of students’ questions and the depth of their observations increased with their knowledge of the topic. This growing interest in the data often resulted in increased desire to learn more GIS skills. These results are very encouraging signs that our materials can be used broadly in Earth sciences, even in classes where the faculty and students have little prior experience with GIS.
Module overview

In this learning module, students explore plate tectonics — the process that governs the large-scale structure of Earth’s surface — by examining the relationships between earthquakes, volcanoes, and plate boundaries.

Key concepts

This module emphasizes three basic concepts.

- Heat is a driving force for plate tectonics.
- Present tectonic activity is a key to the past, and the past can be used to understand the future.
- Hazards become disasters when people are affected.

Unit descriptions

The module consists of five individual units and can be divided into two broad topics: plate tectonics and the geological hazards that arise from the process.

Unit 1 – Searching for Evidence

- Warm-up 1.1 – A changing Earth
  Students identify long- and short-term changes in Earth’s surface and the physical evidence of these changes.
- Investigation 1.2 – Investigating Earth’s clues
  Students investigate patterns in the global distribution of earthquakes, volcanoes, and topographic anomalies.
- Reading 1.3 – Discovering plate tectonics
  Students discover how Earth’s continental and oceanic crust is continually changing at plate boundaries and hotspots. They learn about the three types of plate boundaries.
- Investigation 1.4 – Analyzing plate boundaries
  Students speculate on the locations and types of plate boundaries around the world, based on what they learn in previous investigations. They compare their predictions with the actual locations and types of boundaries.

Unit 2 – Exploring Plate Tectonics

- Warm-up 2.1 – Testing plate tectonics
  Students identify evidence showing Earth’s plates were in different locations in the past.

Learning objectives

Unit 1 objectives

In this unit, students will

- Interpret patterns of seafloor topography, earthquakes, and volcanoes to predict the locations and types of plate boundaries.
- Compare predicted plate boundaries to currently accepted boundaries and evaluate the differences.
- Use relative plate motion data to classify types of plate boundaries.

Module goal

Students will understand key evidence for plate tectonics theory and will use this evidence to verify the theory. They will understand fundamental differences in plate boundaries and how they affect tectonics in those areas. Students will know that plate tectonics has been active for hundreds of millions of years and evidence of past activity is in the rock record.

Additionally, by examining historic hazards, world population and wealth, students will understand the relationship between hazard and risk. They will also be able to develop plans for reducing risk.
Unit 2 objectives
In this unit, students will
- Measure the spreading rate of ocean ridges.
- Use evidence to show that plate motions have changed over time.
- Make predictions of how plates will change over time.

Unit 3 objectives
In this unit, students will
- Explain the causes of deadly earthquakes.
- Describe and explain the causes of the spatial and temporal distribution of deadly earthquakes in historical times.
- Analyze risk factors for a country or region.
- Make predictions about the risk of earthquake hazards by using knowledge of a country’s population density, gross domestic product, and historical seismicity.

Unit 4 objectives
In this unit, students will
- Define VEI and give examples of hazards associated with eruptions of different VEIs.
- Calculate the recurrence interval of eruptions for a particular volcano.
- Explain the relationship between volcanic eruptions and climate.

Investigation 2.2 – Investigating seafloor age
Students explore patterns in seafloor age, the age of continental rocks, and differences in spreading rates between the North and South Atlantic Oceans.

Reading 2.3 – Determining seafloor age
Students learn about paleomagnetism, relative and absolute plate motion, and the use of hotspots as fixed locations for calculating absolute plate motion. They also learn about spreading rates and changes in plate motion with time.

Investigation 2.4 – Investigating plate motion
Students calculate spreading rates and use their results to determine how rates have changed over time. They compare spreading rates between the Atlantic and Pacific Oceans, predict when the Juan de Fuca plate will be subducted completely, and explore hotspot volcanism in the Hawaiian-Emperor chain. Finally, they look at the movement of Los Angeles and San Francisco along the San Andreas fault.

Unit 3 – Earthquake Hazards

Warm-up 3.1 – The Great Lisbon Earthquake
Students explore the major hazards from earthquakes after reading an eyewitness account of the Great Lisbon Earthquake.

Investigation 3.2 – Deadly earthquakes
Students examine earthquake data to locate the largest and most damaging earthquakes. They explore trends in deadly earthquakes throughout history.

Reading 3.3 – Seismic hazards
Students learn about factors that affect earthquake destruction, and they learn about recurrence intervals and how to use them to predict future risks.

Investigation 3.4 – Seismic risk and society
Students examine the relationship between population, national wealth, and seismic risk.

Unit 4 – Volcano Hazards

Warm-up 4.1 – The tragedy of Mont Pelée
Students explore the volcanic eruption of Mont Pelée and the hazards associated with it.

Investigation 4.2 – Deadly volcanoes
Students study historical volcanoes, learn about the volcanic explosivity index (VEI) scale, and determine the recurrence interval for volcanic eruptions.
• **Reading 4.3 – Volcanic hazards**
  Students become familiar with different types of volcanic eruptions and learn about the effect of major eruptions on climate.

• **Investigation 4.4 – Volcanoes and climate**
  Students examine large (VEI 7–8) eruptions and learn how far the effects of the eruptions can spread. They conclude the unit with an investigation of the ashfall plumes at Yellowstone National Park in Wyoming.

**Unit 5 – Tsunami Hazards**

• **Warm-up 5.1 – Scotch Cap Lightstation**
  Students explore the tsunami at the Scotch Cap Lightstation and the hazards associated with it.

• **Investigation 5.2 – Deadly tsunamis**
  Students are introduced to tsunamis and their behavior by analyzing two major tsunami events in Hawaii and Japan.

• **Reading 5.3 – Analysis of a tsunami**
  Students learn what tsunamis are, how they form, how they affect communities, and how communities can prepare for tsunami events.

• **Investigation 5.4 – Tsunami warning**
  Students study the interaction between tsunamis and tides, and examine tsunami trigger events with the goal of developing criteria to use to issue tsunami warnings.

• **Investigation 5.5 – 2004 Indonesian tsunami**
  Students examine the tsunami triggered by the 2004 Indonesian earthquake. They identify the per capita income of various countries and to what extent they were affected by the tsunami.

**National Science Education Standards**

The *Data Detectives* series is correlated to the National Science Education Standards (NSES), as set forth by the National Research Council. The cross-reference chart on the following page shows the standards for grades 9-12 that are either directly or indirectly addressed by each lesson and each unit.

Additional documents correlating these materials with national standards in geography and mathematics may be available from the *Data Detectives* Web site at www.scieds.com/saguaro.
### NSES cross-reference chart, grades 9-12

<table>
<thead>
<tr>
<th>Content Standards</th>
<th>Unit 1 Searching for Evidence</th>
<th>Unit 2 Exploring Plate Tectonics</th>
<th>Unit 3 Earthquake Hazards</th>
<th>Unit 4 Volcano Hazards</th>
<th>Unit 5 Tsunami Hazards</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1.1</td>
<td>1.2</td>
<td>1.3</td>
<td>1.4</td>
<td>2.1</td>
</tr>
<tr>
<td>Unifying Concepts and Processes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System, order, and organization</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Evidence, models, and explanation</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Constancy, change, and measurement</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Evolution and equilibrium</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Form and function</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Science as Inquiry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abilities necessary to do scientific inquiry</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Understanding about scientific inquiry</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Earth and Space Science</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Energy in the Earth system</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Geochemical cycles</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Origin and evolution of the Earth system</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Origin and evolution of the universe</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical Science</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Structure of atoms</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Structure and properties of matter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chemical reactions</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Motions and forces</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Conservation of energy and increase in disorder</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interactions of energy and matter</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Science and Technology</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abilities of technological design</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Understandings about science and technology</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Science in Personal and Social Perspectives</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal and community health</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Population growth</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Natural resources</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Environmental quality</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Natural and human-induced hazards</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Science &amp; technology in local, national, &amp; global challenges</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>History and Nature of Science</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Science as a human endeavor</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Nature of scientific knowledge</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Historical perspectives</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

\[ X = \text{standard is directly addressed} \quad \bullet = \text{underlying concept throughout unit} \]
Teaching tips

A common misconception is that you need to teach your students everything about the GIS software before you can begin using these materials. Extensive field testing has shown that the investigations provide sufficient guidance for beginning users and that students learn best by using the software tools with a minimal introduction.

Preparing your students

Essential skills

The basic skills students need to know are

- Pointing and clicking, manipulating windows and dialog boxes.
- Turning on, turning off, and activating themes (map layers).
- Zooming in and out in map views using zoom tools and buttons.

Activating themes

The most common error by users of all skill levels is forgetting to activate the correct theme before doing a GIS operation, thus performing the right action on the wrong data. We have made an effort to minimize this problem, but when errors do occur, this is the first thing to check!

Entering queries

The second greatest source of errors and frustration occurs when entering data queries using the Query Builder window. ArcView’s query language is simple, but very picky about syntax. The easiest way to avoid these errors is to construct the query statement in the Query Builder window using the “double-click, click, double-click (or type)” method shown at left. If students still have difficulty entering their queries, they can click the QuickLoad Query button to load a pre-built query statement into the window. If you find that your students are having a difficult time creating queries, you may want to have them go directly to the QuickLoad Query approach.

Encourage exploration

Although you may not want students to get too far off track during the investigations, encourage them to explore beyond the instructions and look for interesting patterns and relationships.

Note to ArcView users

If your students are already familiar with ArcView GIS, they will notice that the user interface (buttons and tools) and some of the basic operations (queries, statistics, select by theme, summary tables) in the Data Detectives investigations differ from the standard, default ArcView interface. Our experience using ArcView for our own work and in the
classroom led us to modify the user interface, both to make it easier and more logical to use, and to provide new features, such as the Media Viewer and the QuickLoad function. These changes are accomplished through a series of scripts built into our ArcView project (.apr) files, and do not permanently modify the ArcView GIS application in any way.

For more information on basic GIS skills, there is a brief introduction to ArcView [called the Educator’s Guide to ArcView GIS] in the Docs folder on the CD-ROM. (This guide is based on the default ArcView user interface.)

**Before you begin**

- Anticipate problem areas by running through the activity yourself on the computer before giving it to your students. Be sure to follow the same directions they will be using.
- When copying Unit folders from the CD-ROM, copy the entire Unit folder without changing the names or locations of files or folders within it.
- Normally, detailed directions and screen shots are given only the first time a technique is used in an investigation. Students may have to refer back to an earlier part of the investigation or to the Educator’s Guide to ArcView GIS if they have forgotten how to perform an operation.
- Review the Using these materials section of this guide with your students before starting the first investigation.
- Set the stage for the investigation with a motivating open-ended question, warm-up activity, or introduction.
- You will need to show students where and how to find the required project file on the computer, since this is unique to every situation.
Investigating relevant problems

The SAGUARO Project learning modules focus on investigating topics frequently addressed in Earth-systems science courses that affect students in their daily lives: plate tectonics and geological hazards, severe weather and global climate, water resources, and the ocean environment. Each module contains activities that focus on several related processes and problems. In general, they begin at the global scale and progress to the regional and, in some cases, local-scale studies. The content and form of the inquiry progresses from guided to open-ended as students build on their knowledge and reasoning skills. Threaded throughout each module are animations and other visualizations to enhance understanding.

Thinking scientifically

A geologist makes a living by studying Earth and its history. Whether recording a violent volcanic eruption or mapping the trace of a fault, a successful Earth scientist relies heavily on his or her ability to recognize patterns. Patterns in space and time are the keys to many of the great discoveries about how the Earth works. The activities in this module will help you develop your ability to recognize and interpret nature's fundamental patterns by exploring modern scientific data using a geographic information system (GIS). GIS is a tool for organizing, manipulating, analyzing, and visualizing information about the world using a computer.

Through these exercises you will examine the global patterns of earthquakes, volcanoes, and topography found around the world, retracing some of the same analytical steps followed by scientists as they gradually uncovered the process of plate tectonics. Using these data, you will peer into Earth's past to learn about the ages of the Atlantic and Pacific Oceans, and gaze into a future in which Los Angeles and San Francisco are no longer rivals, but suburbs of one another! Moving from geologic to human time frames, you will examine some recent geologic events, including earthquakes, volcanic eruptions, and tsunamis, to evaluate the risk to societies worldwide from future occurrences of these geologic hazards.

Most of these patterns are presented in maps, which are one of the geologist's most important tools. The maps will allow you to explore the relationships between natural features and phenomena such as the location of rivers, mountains, earthquakes, and volcanic eruptions; and human features such as roads, cities, and population density. By
investigating a map of population density and locations of deadly earthquakes, you can use the patterns in the data to deduce the nature of the relationship between these features. Maps also provide a convenient way to present statistical relationships, and maps of different time intervals allow you to look at changes in features over time. You will even be able to create your own maps and explore some of these patterns in more detail.

**Planning to learn**

Each unit of *Data Detectives: Dynamic Earth* leads students through a well-tested learning process that builds upon their existing knowledge. The first lesson of the unit gets them thinking about the major concepts presented in the unit and the key questions that motivate and guide scientific research. It will help them frame their own questions about the topic — questions that they may be able to answer for themselves as they learn more in later investigations.

In the second lesson, students explore maps and data looking for patterns. As they examine these patterns, they should ask themselves questions such as:

- Where do they occur? (or not occur?)
- Why does this pattern occur here and not elsewhere?
- What might cause this pattern?
- What else is spatially associated with this phenomenon?
- Do these things usually occur together in the same places?
- How has this pattern changed spatially through time?

The third lesson of each unit provides key background information about major scientific principles and concepts, and should help students begin to answer the questions raised earlier. Readings are brief and explain only the important concepts required to continue or to check their prior answers. In the fourth (and sometimes fifth) lesson, students apply their new knowledge to solve a particular problem. This helps students measure their understanding of the material and prepare them for the final lesson where they are asked to apply the concepts they have learned in the unit to a specific location or situation.

**GIS made easier**

The purpose of these investigations is not simply to learn how to use GIS, but to use one as a tool to explore and learn about natural processes and features and how they relate to humans and human activities. For this reason, all of the data have been assembled into ready-to-use projects, and complex operations have been eliminated or simplified. Although it is helpful for students to have basic computer skills, they do not need experience with ArcView GIS software to complete the activities. The ArcView user interface has been modified to simplify
complex and repetitive processes. Directions for each task are provided in the text, so they will learn to use the tool as they explore with it. The activities barely scratch the surface of the data that have been provided, and students are encouraged to explore the data on their own and make their own discoveries.